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Electromagnetic Analysis: Solve 2-D electrostatic and magnetostatic
problems
A new programmatic workflow lets you set up, solve, and analyze 2-D electrostatic and magnetostatic
problems using natural steps and familiar domain-specific language. When setting up an
electromagnetic problem, you can:

• Create a special model container for an electrostatic or magnetostatic model using the
createpde function.

• Assign electromagnetic material properties, such as relative permittivity and relative permeability,
using the electromagneticProperties function.

• Specify a charge density and current density using the electromagneticSource function.
• Set electromagnetic boundary conditions, such as voltage and magnetic potential, using the

electromagneticBC function.

The solve function solves electrostatic or magnetostatic problems and returns the values of electric
or magnetic potential, field, and flux density at nodal locations of the mesh. You can analyze the
resulting solution further by using one of these functions:

• interpolateElectricPotential and interpolateMagneticPotential interpolate the
electric and magnetic potential at nodes to arbitrary spatial locations.

• interpolateElectricField and interpolateMagneticField interpolate the electric and
magnetic field at nodes to arbitrary spatial locations.

• interpolateElectricFlux and interpolateMagneticFlux interpolate the electric and
magnetic flux density at nodes to arbitrary spatial locations.

The pdeplot function visualizes the solution by plotting the resulting potentials, fields, fluxes, and
mesh.

For more details about the new workflow, see “Electromagnetics”.

3-D Geometries: Create a multidomain geometry by inserting one
geometry into another
Combine two 3-D geometries or create void regions inside 3-D geometry using the addCell and
addVoid functions. For these operations, all cells of one geometry must be contained inside one cell
of the other geometry.

Geometry Extrusion: Extrude faces of a 3-D geometry to a specified
height
Extrude faces of a 3-D geometry along the direction normal to all specified faces using the extrude
function. You can extrude faces into multiple layers by specifying a vector height of thicknesses of
the layers. All faces must be flat and must have the same orientation.

R2021a
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Geometry Queries: Find faces, edges, and cells based on their
proximity to other geometric entities
The following functions support geometry queries. They return face and edge IDs that you can use as
arguments for other functions.

• cellFaces and cellEdges find faces and edges attached to the specified cells.
• faceEdges finds edges attached to the specified faces.
• facesAttachedToEdges finds faces attached to the specified edges.
• nearestFace and nearestEdge find faces and edges closest to the specified points.

Geometry Import from STL Files: Import a geometry without creating
a model
The importGeometry function now lets you create a geometry object from an STL geometry file
without attaching the imported geometry to any model. The new syntax is g =
importGeometry('geometryfile.stl'). This approach lets you modify and adapt the geometry
to meet your requirements before attaching it to a model. It also lets you share the same geometry
between models.

PDEVisualization object: Create and plot an object containing nodal
data, mesh, and visualization options as its properties
The pdeviz function uses the mesh and nodal data to create a PDEVisualization object and plot
the result. You can interact with the resulting plot by changing the properties of this object. For
example, you can change the mesh visibility, transparency, mesh deformation, axes labels, and so on.
The plot reflects the new settings without the need to plot the same data repeatedly.

Face Addition and Geometry Transformation for Analytic Geometries:
addFace, rotate, scale, and translate now work with AnalyticGeometry
objects
The addFace function now lets you fill void regions in 2-D AnalyticGeometry objects.

The rotate, scale, and translate functions now work on AnalyticGeometry objects.

PDE Conversion to Divergence Form: Convert PDEs into the form
required by Partial Differential Equation Toolbox using Symbolic Math
Toolbox functions
Partial Differential Equation Toolbox solves equations of the form

m∂2u
∂t2 + d∂u∂t − ∇ · c⊗ ∇u + au = f

The pdeCoefficients and pdeCoefficientsToDouble functions convert PDEs into this form and
extract the coefficients into a structure that can be used by the specifyCoefficients function. For

 

1-3



example, see “Solve Partial Differential Equation of Nonlinear Heat Transfer” (Symbolic Math
Toolbox).
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3-D Geometry Creation: Extrude a 2-D geometry into a 3-D geometry
Extrude a planar geometry along the z-axis to obtain a 3-D geometry. For details, see 3-D
Multidomain Geometry from 2-D Geometry and extrude.

Finite Element Matrices for Custom Workflows: Assemble FE matrices
for time-dependent and nonlinear models
The assembleFEMatrices function, which returns global finite element matrices for structural,
thermal, and general PDE models can now:

• Assemble a subset of matrices, such as updated load only or stiffness only, to save computation
time

• Assemble matrices using input time or solution for a time-dependent or nonlinear model,
respectively

R2020b
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Axisymmetric Analysis: Speed up simulations by simplifying 3-D solids
of revolution by analyzing only the 2-D axisymmetric sections
Simplify 3-D structural and thermal problems to 2-D using their symmetry around the axis of rotation.
The toolbox now supports an axisymmetric analysis for linear elasticity and heat transfer problems
and enables you to:

• Create an axisymmetric 2-D model for a structural or thermal problem. See createpde.
• Set up an axisymmetric problem and analyze the results in cylindrical coordinates. In particular,

you can specify the enforced displacement for a structural axisymmetric model. See
structuralBC.

• Model the effect of a spinning axisymmetric structure by specifying a centrifugal load. For details,
see structuralBodyLoad.

For a heat transfer example, see Heat Distribution in Circular Cylindrical Rod.

Multidomain Geometry: Split cells and fill voids to create multiple
domains with different properties
Use the addFace function to create new geometric faces in 2-D and 3-D geometries. Adding a new
face lets you modify a geometry:

• In a 2-D geometry, a new face fills a void region. The new face can have its own properties, such
as thermal or structural material properties, or become an internal heat source.

• In a 3-D geometry, a new face splits a cell into two cells. Splitting cells lets you convert a single
domain geometry (created by importGeometry, for example) to a multidomain geometry. Each
cell (domain) can have its own properties.

Geometry Transformation: Manipulate geometries to preferred
orientation and size by rotation, scaling, and translation
The toolbox supports these geometry transformations:

• Rotation around an arbitrary axis using the rotate function.
• Scaling up or down along each Cartesian axis independently with respect to a reference point

using the scale function.
• Translation in any direction using the translate function.

Modal Damping: Include damping in modal transient and frequency
response simulations
For modal transient and modal frequency response models, specify damping as a percentage of
critical damping for a selected vibration frequency. The toolbox enables you to specify the modal
damping parameter as:

• Constant modal damping ratio for all modes
• Frequency-dependent modal damping ratio using a function handle

R2020a
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See structuralDamping and Dynamics of Damped Cantilever Beam.

pdegplot, pdemesh, pdeplot, and pdeplot3D Functions: Improved
performance for plots with many text labels
The PDE plotting functions show faster rendering and better responsiveness for plots that display
many text labels. For example, this code shows about a 3x increase in speed:

model = createpde;
importGeometry(model,'Block.stl') 
generateMesh(model) 
pdemesh(model,'NodeLabels','on') 

Compatibility Considerations
Code containing findobj(fig,'Type','Text') no longer returns labels on figures produced by
the PDE plotting functions.
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Reduced Order Modeling: Approximate dynamic characteristics of a
structural model for faster execution
The toolbox now supports the Craig-Bampton component mode synthesis workflow for structural
mechanics.

Finite-element discretized models can be very large. Model order reduction techniques approximate
the dynamics of the original system with a smaller system while retaining most of the dynamic
characteristics.

When using the reduced-order model workflow, you can:

• Specify structural superelement interfaces. See structuralSEInterface.
• Reduce a structural analysis model to all modes in the specified frequency range and the interface

degrees of freedom. See reduce.

Simscape Multibody Models: Generate dynamic substructure for
flexible multibody simulations
You can use results obtained with the model order-reduction technique to provide data for
Simscape™ Multibody™ flexible body block.

Simscape models expect the connections at all joints to have six degrees of freedom, while Partial
Differential Equation Toolbox uses two or three degrees of freedom at each node. To interface with
Simscape joints, set multipoint constraints by using the structuralBC function. Setting a multipoint
constraint ensures that all nodes and all degrees of freedom have a rigid constraint with the
geometric center of all specified geometric regions together as the reference point. The reference
location has six degrees of freedom.

To recover a full-model transient solution from reduced-order model results and Simscape solution,
use the reconstructSolution function.

For an example of a Simscape Multibody workflow that uses a reduced order model, see Model an
Excavator Dipper Arm as a Flexible Body (Simscape Multibody).

Frequency Response Analysis: Determine dynamic response of a
structure in the frequency domain
Determining the dynamic response of a structure under various forms of excitation is a common task
in structural analysis. This problem can be formulated over time domain (in which case it is called
transient response analysis) or frequency domain (called frequency response analysis or sometimes
harmonic analysis).

In addition to the transient dynamic analysis, the toolbox now supports the frequency response
analysis for structural models. When setting up a linear elasticity problem, you can:

• Create a special model container for a frequency response structural analysis. See createpde.
• Specify a boundary load, for example, pressure. See structuralBoundaryLoad.
• Solve the problem and obtain displacement, velocity, acceleration, and solution frequencies at

nodal locations of the mesh. See solve.

R2019b
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• To speed up computations, you can use modal analysis results for frequency response analysis.
The ModalResults argument triggers the solve function to use the modal superposition
method.

Structural Analysis: Set concentrated boundary conditions at arbitrary
locations on geometry surfaces
Use addVertex to create new vertices at any points on boundaries of a 2-D or 3-D geometry
represented by a DiscreteGeometry object. Then use structuralBC or
structuralBoundaryLoad to set concentrated boundary constraints and loads at these vertices.

For an example of applying a point load on a geometric boundary, see Reduced-Order Modeling
Technique for Beam with Point Load.

Eigenvalue Solver Options: Specify parameters for Lanczos algorithm
Solvers for structural modal analysis problems and reduced-order modeling use the Lanczos
algorithm. Use PDESolverOptions to specify the maximum number of Lanczos shifts and the block
size for block Lanczos recurrence.
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Structural Analysis: Set boundary constraints and loads on edges and
vertices
The workflow for structural analysis problems lets you specify an enforced displacement and the
'free' and 'fixed' boundary constraints on vertices and edges for both 2-D and 3-D models. To
specify boundary constraints and a displacement, including spatial components of displacement, use
the structuralBC function. The previous versions of this function let you specify the displacement
and boundary constraints values only on edges for 2-D models and faces on 3-D models.

You can specify concentrated force at a vertex by using the structuralBoundaryLoad function.

Structural Analysis: Compute transient response by using the modal
superposition method
By default, the solve function uses the direct integration approach which can be slow. To speed up
calculations, transient dynamics analysis can be performed using modal analysis results. The new
ModalResults argument triggers the solve function to switch to the modal transient solver instead
of using the direct integration approach.

Finite Element Matrices: Assemble global finite element matrices for
thermal and structural models
The assembleFEMatrices function accepts thermal and structural models with time- and solution-
independent coefficients.
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Thermal Load: Evaluate thermal stress and thermal expansion in
static structural analysis
The programmatic workflow for static structural analysis problems now lets you account for thermal
loading. When setting up a static structural problem, you can:

• Specify a coefficient of thermal expansion as a structural material property. See
structuralProperties.

• Specify a thermal load as a body load. Use a constant temperature to specify a steady and uniform
thermal load or use previously obtained results of thermal analysis to specify a nonuniform
thermal load. See structuralBodyLoad.

• Specify a reference temperature. This temperature corresponds to the state of the model at which
both thermal stress and strain are zeros. See StructuralModel.

The solve function solves a static structural analysis model accounting for mechanical and thermal
effects. The function returns a displacement, stress, strain, and von Mises stress induced by both
mechanical and thermal loads.

For an example of the new workflow, see Thermal Deflection of Bimetallic Beam.
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Structural Analysis: Solve linear transient dynamic problems using
direct time integration
The programmatic workflow for structural analysis problems now lets you set up, solve, and analyze
dynamic linear elasticity problems using a familiar domain-specific language. Most steps correspond
to the similar steps for setting up a static linear elasticity problem. Additional options for a dynamic
linear elasticity problem include:

• Specifying proportional (Rayleigh) mass and stiffness damping parameters. See
structuralDamping.

• Specifying initial conditions. See structuralIC.
• Specifying time-dependent boundary loads by using function handles. Also, you can specify the

form and duration of the pressure pulse and the frequency and phase of sinusoidal pressure by
using the corresponding name-value pair arguments. See structuralBoundaryLoad.

• Specifying time-dependent boundary loads by using function handles. Also, you can specify the
form and duration of x-, y-, or z-component of the enforced displacement and the frequency and
phase of sinusoidal displacement by using the corresponding name-value pair arguments. See
structuralBC.

The solve function solves a dynamic structural analysis model and returns displacement, velocity,
and acceleration at nodal locations of the mesh. You can analyze the resulting solution further by
using one of these functions:

• evaluateStress evaluates stress at nodal locations for all time steps.
• evaluateStrain evaluates strain at nodal locations for all time steps.
• evaluateVonMisesStress evaluates von Mises stress at nodal locations for all time steps.
• evaluateReaction evaluates reaction forces on a specified boundary.
• evaluatePrincipalStress and evaluatePrincipalStrain evaluate principal stress and

strain at mesh nodes.
• interpolateDisplacement interpolates displacements at arbitrary spatial locations.
• interpolateVelocity interpolates velocities at arbitrary spatial locations.
• interpolateAcceleration interpolates accelerations at arbitrary spatial locations.
• interpolateStress and interpolateStrain interpolate stress and strain at arbitrary spatial

locations.
• interpolateVonMisesStress interpolates von Mises stress at arbitrary spatial locations.

For more details about the new workflow, see Structural Mechanics.

Modal Analysis: Find natural frequencies and mode shapes
The programmatic workflow for modal analysis problems lets you find natural frequencies and mode
shapes of a structure. Use the same steps for creating a modal analysis model and specifying
materials and boundary constraints as for static linear elasticity problems. When solving a modal
analysis model, the solver requires a frequency range parameter and returns the modal solution in
that frequency range. See Vibration of Square Plate.
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Mesh Analysis: Assess element quality, measure element area or
volume, and find nodes and elements
The findElements and findNodes functions return collections of mesh elements and nodes
associated with a particular geometric region (edge, face, and so on), located within a bounding box
or disk, or located close to a specified point or node. These functions return node or element IDs that
you can use as arguments for other mesh query functions or plotting functions.

The meshQuality function lets you assess shape quality of mesh elements of an entire mesh or a
particular group of elements. Using this function, you can analyze the shape quality of each element
of a 2-D or 3-D mesh, locate the elements of low quality, and adjust you mesh-generation parameters
accordingly.

The area and volume functions measure areas and volumes covered by individual elements and
groups of elements of 2-D and 3-D meshes, respectively.

The pdemesh, pdeplot, and pdeplot3D functions accept node and element IDs as input arguments,
which lets you highlight particular nodes and elements on mesh plots.

Geometry from Mesh: Create multidomain geometry from nodes and
elements
The geometryFromMesh function creates a geometric model from a triangulated mesh, including
planar, volume, and surface triangulation that bounds a closed volume. This function lets you create a
multidomain geometry by specifying the subdomain ID for each element of the mesh. You can retain
the original mesh or generate a new one by using the generateMesh function.

Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility Considerations
pdesdp Still runs findNodes Use a PDEModel object to set up and

solve a PDE problem. For the step-
by-step workflow, see Solve Problems
Using PDEModel Objects. PDEModel
stores a finite element mesh as a
FEMesh object in its Mesh property.
Use the findNodes function to find
mesh nodes that belong to particular
regions.

pdesdt Still runs findElements Use findElements to find mesh
elements that belong to particular
regions.

pdetrg Still runs area Use the area function to compute
areas of 2-D mesh elements.

pdetriq Still runs meshQuality Use the meshQuality function to
evaluate shape quality of mesh
elements.
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Functionality Result Use Instead Compatibility Considerations
pdegrad Still runs evaluateGradient Use the evaluateGradient

function to evaluate the gradient of a
PDE solution.

pdecgrad Still runs evaluateCGradient Use the evaluateCGradient
function to evaluate the flux of a PDE
solution.
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Structural Analysis: Solve static linear elasticity problems
A new programmatic workflow lets you set up, solve, and analyze static linear elasticity problems
using a familiar domain-specific language. When setting up a static linear elasticity problem, you can:

• Create a special model container for a static structural analysis. See createpde.
• Assign structural properties of the material, such as Young's modulus, Poisson's ratio, and mass

density. See structuralProperties.
• Specify a body load for a structural model. See structuralBodyLoad.
• Specify pressure, surface traction, and translational stiffness for a particular boundary. See

structuralBoundaryLoad.
• Specify enforced displacement and boundary constraints for a particular boundary. See

structuralBC.

The solve function solves a static structural analysis model and returns displacement, stress, strain,
and von Mises stress at nodal locations of the mesh. You can analyze the resulting solution further by
using one of these functions:

• interpolateDisplacement interpolates displacements at arbitrary spatial locations.
• interpolateStress and interpolateStrain interpolate stress and strain at arbitrary spatial

locations.
• interpolateVonMisesStress interpolates von Mises stress at arbitrary spatial locations.
• evaluateReaction evaluates reaction forces on a specified boundary.
• evaluatePrincipalStress and evaluatePrincipalStrain evaluate principal stress and

strain at mesh nodes.

The pdeplot and pdeplot3D functions let you visualize the solution by plotting the resulting
displacements, stresses, and strains.

For more details about the new workflow, see Structural Mechanics.

Planar STL Geometry: Import and mesh planar STL geometries
importGeometry can import a planar STL geometry and convert it to a 2-D geometry by mapping it
to the X-Y plane. To mesh the resulting 2-D geometry, use generateMesh.

Meshing: Improved mesh generation
The mesh generator, generateMesh, now:

• Uses new mesh generation algorithm for 2-D geometries.
• Lets you specify mesh growth rate for both 2-D and 3-D meshes. To specify mesh growth rate, use

the Hgrad argument of generateMesh.

Compatibility Considerations
Resulting meshes can differ from meshes generated in previous releases. For example, meshes
generated with the default size controls can have fewer elements than before.
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Also, generateMesh creates quadratic meshes for 2-D problems by default. In previous releases, the
default mesh for 2-D geometries is a linear mesh. For both 2-D and 3-D geometries, you can specify
whether you want to use linear or quadratic mesh by using the GeometricOrder argument of
generateMesh.

Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility Considerations
Function handle for
specifying nonconstant
boundary conditions and
coefficients of the form
@f(problem,
region,state)

Still runs @f(region,state) Use the two-argument form,
@f(region,state), to define a
function handle for
applyBoundaryCondition or
specifyCoefficients.

pdetool Still runs pdeModeler The function name pdetool has
been changed to pdeModeler.

Opening the PDE Modeler
app by calling
pdeModeler or pdetool
or by using the Apps tab

Does not
overwrite
existing
information
in the app
anymore

To overwrite the existing
information in the PDE
Modeler app, select File >
New.

In previous releases, starting the
PDE Modeler app and then
reopening the app by calling
pdetool or by using the Apps tab
overwrites any existing information
in the app. Now, reopening the PDE
Modeler app brings focus to the app
window.

Jiggle, JiggleIter, and
MesherVersion
arguments of
generateMesh

Ignored No replacement generateMesh produces good
quality meshes without jiggling the
nodes.
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Thermal Analysis: Solve conduction-dominant heat transfer problems
with convection and radiation occurring at boundaries
A new programmatic workflow lets you set up, solve, and analyze conduction-dominant heat transfer
problems using natural steps and familiar domain-specific language. When setting up a heat transfer
problem, you can:

• Create a special model container for a steady-state or transient thermal model. See createpde.
• Assign thermal properties of the material, such as thermal conductivity, specific heat, and mass

density. See thermalProperties.
• Specify internal heat sources of the geometry. See internalHeatSource.
• Set temperatures on boundaries, specify insulated boundaries, heat fluxes through boundaries,

convection coefficients, radiation emissivity coefficients, and ambient temperature. See
thermalBC.

• Set initial temperature or initial guess for temperature. See thermalIC.

The solve function solves steady-state and transient thermal models and returns temperatures and
temperature gradients at nodal locations of the thermal model mesh. You can analyze the resulting
solution further by using one of these functions:

• interpolateTemperature interpolates resulting temperatures to arbitrary spatial locations.
• evaluateTemperatureGradient evaluates temperature gradient for a transient thermal

solution at arbitrary spatial locations.
• evaluateHeatFlux evaluates heat flux of a thermal solution at nodal or arbitrary spatial

locations.
• evaluateHeatRate evaluates integrated heat flow rate normal to specified boundary.

The pdeplot and pdeplot3D functions let you visualize a thermal model solution by plotting the
resulting temperatures, and temperature gradients, and mesh.

There is a new featured example showing heat transfer in a transient 3-D model, Heat Conduction in
a Spherical Multidomain Geometry with Nonuniform Heat Flux.

For more details about the new workflow, see Heat Transfer.

3-D Multidomain Geometry: Create geometries consisting of stacked
or nested cuboids, spheres, or cylinders
The multicuboid, multicylinder, and multisphere functions create 3-D geometries formed by
several cubic, cylindrical, and spherical cells, respectively. With these functions, you can create
stacked or nested geometries. You also can create geometries where some cells are empty, for
example, hollow cylinders, cubes, or spheres.

All cells in a geometry must be of the same type: either cuboids, or cylinders, or spheres. These
functions do not combine cells of different types in one geometry.
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Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility Considerations
pdemdlcv Errors No replacement Remove all instances of pdemdlcv.
Function handle for
specifying nonconstant
boundary conditions and
coefficients of the
form@f(problem,
region,state).

Still runs @f(region,state) Use the two-argument form,
@f(region,state), to define a
function handle for
applyBoundaryCondition or
specifyCoefficients.
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Flux of PDE Solution: Evaluate tensor product of c-coefficient and
gradient of PDE solution for 2-D and 3-D problems
The evaluateCGradient function computes the tensor product of c-coefficient and gradients of the
PDE solution, c⊗ ∇u, at nodal or arbitrary locations in 2-D or 3-D geometry.

Boundary Conditions: Set an individual boundary condition for each
equation in a PDE system, query boundary condition assignments
The applyBoundaryCondition function can set an individual boundary condition for each equation
in a system of PDEs in one function call. For example, in a system of two PDEs, one
applyBoundaryConditions call can set the Dirichlet boundary condition for the first equation, and
the Neumann boundary condition for the second equation.

The function uses clear precedence rules to decide which condition to use for every geometric region.

The findBoundaryConditions function returns the currently used boundary condition assignment
for a geometric region.

Compatibility Considerations
The new syntax requires explicit specification of the boundary condition type as 'dirichlet',
'neumann', or 'mixed'. For example, in previous releases you used the following syntaxes to apply
the Dirichlet boundary condition on edge 1 and Neumann boundary condition on face 2.

applyBoundaryCondition(model,'Edge',1,'u',0);
applyBoundaryCondition(model,'Face',2,'g',0,'q',0);

Update them to specify the boundary condition types.

applyBoundaryCondition(model,'dirichlet','Edge',1,'u',0);
applyBoundaryCondition(model,'neumann','Face',2,'g',0,'q',0);

Previously, to set the Dirichlet boundary condition for one equation in a PDE system and the
Neumann boundary condition for another, you used two function calls to
applyBoundaryCondition.

applyBoundaryCondition(model,'edge',4,'u',0,'EquationIndex',1);
applyBoundaryCondition(model,'edge',4,'g',[0,-1]);

Now, set both boundary conditions in one function call by specifying the boundary condition type as
'mixed'.

applyBoundaryCondition(model,'mixed','edge',4,'u',0,...
                             'EquationIndex',1,'g',[0,-1]);

Nodal Initial Conditions: Set nodal initial conditions using the result of
a previous simulation
The setInitialConditions function sets initial conditions at the mesh nodes by using the solution
from a previous analysis on the same geometry and mesh.
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Geometric Initial Conditions: Set initial conditions on vertices, edges,
faces, and cells
The setInitialConditions function sets initial conditions on faces, edges, and vertices for both 2-
D and 3-D geometries, and on cells for 3-D geometry. You can set initial conditions on particular
vertices, edges, faces, and cells or set global initial conditions on all vertices, edges, faces, or cells in
the geometry.

Mesh and Solution Plots: Set transparency, display node and element
labels
The FaceAlpha argument of pdegplot, pdemesh, pdeplot, and pdeplot3D lets you set the plot
transparency.

The ElementLabels argument of pdemesh, pdeplot, and pdeplot3D lets you display element
labels.

The NodeLabels argument of pdemesh and pdeplot lets you display node labels.

The VertexLabels and CellLabels arguments of pdegplot let you display vertex and cell labels.

Compatibility Considerations
The argument SubdomainLabels is no longer recommended. Use FaceLabels for 2-D geometries
instead.

3-D Geometry Import from STL Files: Improved quality of the resulting
geometry
When importing an STL geometry for a 3-D problem, importGeometry can recognize and
reconstruct more geometric vertices, edges, and faces of the original CAD geometry in some
instances. In these cases, the resulting geometry is a closer match to the original CAD geometry.

Compatibility Considerations
Detailed geometries can now contain more faces and edges than in previous releases. As a result, in
rare instances, the new faces and edges can cause renumbering of the existing ones. If your code
imports an STL geometry, visually check the geometry to ensure that you are assigning boundary and
initial conditions to the intended regions.

Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility Considerations
pdemdlcv Warns No replacement Remove all instances of pdemdlcv.
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Functionality Result Use Instead Compatibility Considerations
pde Errors createpde Use createpde to create a

PDEModel that holds the PDE
analysis data.

The pde class was a value class. The
replacement PDEModel class is a
handle class.

pdeGeometryFromEdges Errors geometryFromEdges Use geometryFromEdges instead.

Although pdeBoundaryConditions
still runs with a warning, its returned
type has changed from a
pdeGeometry object to an
AnalyticGeometry object. The
pdeGeometry class was a value
class. The replacement
AnalyticGeometry class is a
handle class.

pdeBoundaryCondition
s

Errors applyBoundaryCondition Replace all instances of
pdeBoundaryConditions(Applic
ationRegion,...) with
applyBoundaryCondition(model
,BCType,'edge',EdgeID,...)

Although pdeBoundaryConditions
still runs with a warning, its returned
type has changed from a
pdeBoundaryConditions object to
a 1BoundaryCondition object. The
pdeBoundaryConditions class was
a value class. The replacement
BoundaryCondition class is a
handle class.

Function handle for
specifying nonconstant
boundary conditions and
coefficients of the form
@f(problem,
region,state).

Still runs @f(region,state) Use specifyCoefficients and
define a function handle that takes
only two arguments:

@f(region,state)
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PDE Solvers: Use solvepde and solvepdeeig functions to solve PDEs
and PDE eigenvalue problems
New solver functions for PDEModel:

• solvepde replaces assempde, pdenonlin, hyperbolic, and parabolic.
• solvepdeeig replaces pdeeig.

To use the new solvers, include PDE coefficients in your model using specifyCoefficients.
Include initial conditions in your model using setInitialConditions.

The new solvers return results as one of the three new objects:

• StationaryResults — Returned by solvepde for a stationary PDE model.
• TimeDependentResults — Returned by solvepde for a time-dependent PDE model.
• EigenResults — Returned by solvepdeeig.

StationaryResults and TimeDependentResults objects contain solution gradients at the nodes.

PDE Coefficients: Specify equation coefficients as a property of
PDEModel
The specifyCoefficients function specifies equation coefficients as a property of PDEModel.

Initial Conditions: Set initial conditions or initial guess as a property
of PDEModel
The setInitialConditions function specifies initial conditions as a property of PDEModel.

Quadratic Elements for 2-D Mesh: Generate 2-D mesh using quadratic
triangular elements
Create a quadratic mesh for 2-D problems using generateMesh with GeometricOrder set to
'quadratic'.

Gradient of PDE Solution: Evaluate solution gradient at arbitrary 2-D
or 3-D points
The evaluateGradient function enables you to interpolate the gradient of a StationaryResults
or TimeDependentResults object at arbitrary points in the geometry.

Finite Element Matrices: Use assembleFEMatrices to assemble finite
element matrices
The assembleFEMatrices function assembles finite element matrices for independent factoring and
solution using linear algebra methods. It replaces assempde, assema, and assemb for matrix
assembly.
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PDE Results for Plotting and Postprocessing: New result objects
depend on the type of PDE
The createPDEResults function returns results as one of the three new objects, depending on the
type of the PDE problem.

• A StationaryResults object for a stationary PDE model. StationaryResults contains the
solution of PDE and its gradients at the nodal locations.

• A TimeDependentResults object for a time-dependent PDE model. TimeDependentResults
contains the solution of PDE and its gradients at the nodal locations.

• A EigenResults object for an eigenvalue problem.

Compatibility Considerations
createPDEResults no longer creates an object of type PDEResults.

The syntax of createPDEResults has changed to accommodate creating the new result types for
time-dependent and eigenvalue problems.

• To create the TimeDependentResults object for a time-dependent problem, use the syntax
createPDEResults(pdem,u,utimes,'time-dependent'), where utimes is a vector of
solution times.

• To create the EigenResults object for an eigenvalue problem, use the syntax
createPDEResults(pdem,eigenvectors,eigenvalues,'eigen').

EigenResults has different property names than PDEResults. Update any eigenvalue scripts that
use PDEResults property names.

Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility Considerations
wbound Still runs No replacement New features and the recommended

workflow are not compatible with
this function.

For the recommended workflow, see
Solve Problems Using PDEModel
Objects.

pdeadgsc and
pdeadworst

Still runs No replacement New features and the recommended
workflow are not compatible with
these functions.

For the recommended workflow, see
Solve Problems Using PDEModel
Objects.
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Functionality Result Use Instead Compatibility Considerations
assempde, assema,
assemb, hyperbolic,
parabolic, pdenonlin

Still runs solvepde and
assembleFEMatrices

To solve PDE problems, use
solvepde. To obtain finite element
matrices, use
assembleFEMatrices.

For the recommended workflow, see
Solve Problems Using PDEModel
Objects.

pdeeig and sptarn Still runs solvepdeeig To solve PDE eigenvalue problems,
use solvepdeeig.

For the recommended workflow, see
Solve Problems Using PDEModel
Objects.

poimesh, poiasma,
poicalc, poiindex,
poisolv

Still runs solvepde To solve Poisson's equations, use
solvepde. For details, see Solve
Problems Using PDEModel Objects.

pdejmps Still runs No replacement New features and the recommended
workflow are not compatible with
this function.

For the recommended workflow, see
Solve Problems Using PDEModel
Objects.

pdesmech Still runs PDE app Use the PDE app instead of
pdesmech.

dst and idst Still runs No replacement Remove all instances of dst and
idst.

tri2grid and pdeintrp Still runs interpolateSolution Use the interpolation function
interpolateSolution provided by
StationaryResults,
TimeDependentResults and
EigenResults.

pdeprtni Still runs No replacement NodalSolution is a property of
StationaryResults and
TimeDependentResults.

Eigenvectors is the corresponding
property of EigenResults.

pdemdlcv Still runs No replacement Remove all instances of pdemdlcv.
pde Warns createpde Use createpde to create a

PDEModel that holds the PDE
analysis data.

The pde class was a value class. The
replacement PDEModel class is a
handle class.
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Functionality Result Use Instead Compatibility Considerations
pdeGeometryFromEdges Warns geometryFromEdges Use geometryFromEdges instead.

Although pdeBoundaryConditions
still runs with a warning, its returned
type has changed from a
pdeGeometry object to an
AnalyticGeometry object. The
pdeGeometry class was a value
class. The replacement
AnalyticGeometry class is a
handle class.

pdeBoundaryCondition
s

Warns applyBoundaryCondition Replace all instances of
pdeBoundaryConditions(Applic
ationRegion,...) with
applyBoundaryCondition(model
,'edge',EdgeID,...)

Although pdeBoundaryConditions
still runs with a warning, its returned
type has changed from a
pdeBoundaryConditions object to
a BoundaryCondition object. The
pdeBoundaryConditions class was
a value class. The replacement
BoundaryCondition class is a
handle class.

Loading a
pdeBoundaryCondition
s object from an R2014b
MAT file.

Errors applyBoundaryCondition Recreate the Boundary Conditions
using applyBoundaryCondition.

Function handle for
specifying nonconstant
boundary conditions and
coefficients of the form
@f(problem,
region,state).

Still runs @f(region,state) Use specifyCoefficients and
define a function handle that takes
only two arguments:

@f(region,state)
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3-D geometry creation from a finite element mesh using the
geometryFromMesh function
The geometryFromMesh function creates 3-D geometry from a finite element mesh, or from a
triangulated surface mesh. For details, see the function reference page or Create and View 3-D
Geometry.

Data structure to represent solutions using the createPDEResults
function
The createPDEResults function converts a PDE solution into a PDEResults object. The
PDEResults object allows you to interpolate the solution using interpolateSolution. For details,
see the reference pages.

Functionality Being Removed or Changed
Functionality Result Use Instead Compatibility

Considerations
pdesmech Still runs PDE app Use the PDE app

instead of pdesmech
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3-D finite element analysis
You can now solve partial differential equations with 3-D geometry. To do so, there is a new workflow
that combines the geometry, mesh, and boundary conditions into a PDEModel object. You can also use
this workflow for 2-D geometry. For details, see Solve Problems Using PDEModel Objects.

Equation coefficients and boundary conditions for 3-D problems
To specify problem coefficients or boundary conditions in 3-D geometry, you can use strings with a
syntax similar to that of a 2-D problem. There is a new way of writing functions for coefficients in 3-D
geometries. For details, see PDE Coefficients and Boundary Conditions.

Compatibility Considerations
To accommodate both 2-D and 3-D geometry, the format of boundary condition objects changed from
that introduced in R2014b. The new object is BoundaryCondition Properties, and calling
pdeBoundaryConditions now warns that it will be removed in a future release. If you saved a
pdeBoundaryConditions object in an R2014b-format MAT file, then loading that file in R2015a can
produce an error. Additionally, the syntax for specifying nonconstant boundary conditions has
changed. Functions written in the previous syntax continue to work for now.

R2014b Syntax R2015a Syntax
function bcMatrix =
myfun(problem,region,state)

function bcMatrix =
myfun(region,state)

For details, see Changes to Boundary Conditions Object From R2014b.

Elliptic, parabolic, hyperbolic, nonlinear, eigenvalue solvers for 3-D
problems
The main toolbox solvers now support problems with 3-D geometry. For a listing of functions that do
or do not support 3-D geometry, see Functions That Support 3-D Geometry. Solvers take a model
argument instead of the previous b, p, e, t arguments. For details, see the function reference pages.

3-D geometry import from STL files
Import the geometry for a 3-D problem in the STL file format using the importGeometry function.
For details, see Create and View 3-D Geometry.

3-D unstructured meshing using tetrahedra
Create finite element meshes using the generateMesh function. For 3-D geometry, the meshes
consist of tetrahedra. See Mesh Data for [p,e,t] Triples: 3-D.

Plot function to inspect 3-D solutions
The pdeplot3D function plots solutions on the boundaries of 3-D geometry. For details, see Plot 3-D
Solutions.
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Featured examples with 3-D geometry
There are two new featured examples related to linear elasticity that have 3-D geometry:

• Deflection Analysis of a Bracket
• Vibration of a Square Plate

There is also a new example of plotting slices through a 3-D solution: Contour Slices Through a 3-D
Solution.

To run the examples at the MATLAB® command line:

echodemo StrainedBracketExample
echodemo Eigenvaluesofa3DPlateExample
echodemo ContourSlices3DExample

pdebound and pdegeom reference pages removed
The pdebound and pdegeom reference pages have been replaced by the Boundary Conditions and 2-
D Geometry documentation categories.
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Functions for modular definition of boundary conditions
To specify PDE boundary conditions in a modular fashion, per edge or set of edges, use a
pdeBoundaryConditions specification. For details, see Steps to Specify a Boundary Conditions
Object.

pdeInterpolant object for solution interpolation
Interpolate a PDE solution to a set of points using evaluate on an interpolant. Create the
interpolant using pdeInterpolant.

R2014b
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Damping option for hyperbolic solver
You can include damping in the hyperbolic solver in matrix form. There is a new example of
dynamics of a damped cantilever beam that shows how to use this feature.

R2014a
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Display option in hyperbolic and parabolic solvers
You can disable the display of internal ODE solution details that the hyperbolic and parabolic
solvers report. To disable the display, set the Stats name-value pair to 'off'.

Eigenvalue example
There is a new example of eigenvalues of a circular membrane. View the example here. To run the
example at the MATLAB command line:

echodemo eigsExample

R2013b
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Performance and robustness enhancements in meshing algorithm
The meshing (geometry triangulation) functions in initmesh and adaptmesh provide an
enhancement option for increased meshing speed and robustness. Choose the enhanced algorithm by
setting the MesherVersion name-value pair to 'R2013a'. The default MesherVersion value of
'preR2013a' gives the same mesh as previous toolbox versions.

The enhancement is available inpdetool from the Mesh > Parameters > Mesher version menu.

New example
There is a new example of heat distribution in a radioactive rod. View the example here. To run the
example at the MATLAB command line:

echodemo radioactiveRod

R2013a

17-2

https://www.mathworks.com/help/releases/R2013a/pde/ug/initmesh.html
https://www.mathworks.com/help/releases/R2013a/pde/ug/adaptmesh.html
https://www.mathworks.com/help/releases/R2013a/pde/examples/heat-distribution-in-radioactive-rod.html


R2012b

Version: 1.1

New Features

Compatibility Considerations

18



Coefficients of parabolic and hyperbolic PDEs that can be functions of
the solution and its gradient
You can now solve parabolic and hyperbolic equations whose coefficients depend on the solution u or
on the gradient of u. Use the parabolic or hyperbolic commands, or solve the equations using
pdetool. For details, see the function reference pages.

Graphics export from pdetool
You can save the current pdetool figure in a variety of image formats. Save the figure using the File
> Export Image menu. See File Menu.

pdegplot labels edges and subdomains
pdegplot now optionally labels:

• The edges in the geometry
• The subdomains in the geometry

To obtain these labels, set the edgeLabels or subdomainLabels name-value pairs to 'on'. For
details, see the pdegplot reference page.

New examples
There is a new example of uniform pressure load on a thin plate. View the example here. To run the
example at the MATLAB command line:

echodemo clampedSquarePlateExample

There is a new example of nonlinear heat transfer in a thin plate. View the example here. To run the
example at the MATLAB command line:

echodemo heatTransferThinPlateExample

There is a new example of a system of coupled PDEs. View the example here. To run the example at
the MATLAB command line:

echodemo deflectionPiezoelectricActuator

pdesmech shear strain calculation change
The pdesmech function now calculates shear strain according to the engineering shear strain
definition. This has always been the documented behavior. However, the previous calculation was
performed according to the tensor shear strain calculation, which gives half the value of the
engineering shear strain.

Compatibility Considerations
pdesmech now returns shear strain values exactly twice as large as before.
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